
SES Moored Instrument Data Set

The SES moored instrument data comprises a significant part of the SES
data set.  The experiment specification comprised a series of stations along
two lines (‘S’ and ‘N’) that were to be occupied continuously by current
meters, thermistor chains, transmissometers and fluorometers from March
1995 to September 1996.  In addition, moorings were deployed to look at
cascading off the shelf and to determine boundary conditions from the Tiree
Passage.

Unfortunately, these stations were located in a major commercial fishery and
losses were heavy.  Nevertheless, over 250 series of moored instrument data
were obtained as follows:

102 Aanderaa Current Meter Series
55 Thermistor Chain Series
18 Fluorometer Series
16 Moored ADCP Series
16 Transmissometer records
15 Temperature Probe Series
11 Bottom Pressure Records
9 EM Current Meter Series
5 Colour Sensor Series
3 Meteorological Buoy Records
2 STABLE Deployments
1 Waverider Record

Details of precise locations, times and instrument types may be found in
either spreadsheet inventories supplied with the data or from the SES
database.

The data are subdivided into two groups. The first of these are conventional
time series where the instrument sampled at pre-set regular intervals of the
order of several minutes to an hour. The second are burst recorded data
where the instrument sampled at high frequency for a period of several
minutes followed by a period of inactivity. This latter category is confined to
the STABLE II lander deployments.



Conventional Time Series Data

The conventional time series data may be found in the subdirectories of the
MOORINGS directory on Disk 2 of the SES CD-ROM set.  These are:

ADCP Moored ADCP data
FLTRANS Fluorometer and transmissometer data
MET Meteorological buoy and colour sensor data
RCM Aanderaa current meter data
S4 S4 current meter data
SFPG Seafloor pressure gauge data
TCHN Thermistor chain data
TPROBE Temperature probe data
WAVE Waverider data

Users interested in transmissometer data should note that many of the
Aanderaa current meters used during SES included a transmissometer in the
fin.

A spreadsheet in ASCII comma separated variable format and Excel 8.0
format (MOORINV.CSV and MOORINV.XLS) is included in the MOORINGS
directory that provides an index to the data files. The data filenames are of
the form Bnnnnnnn.LST or Bnnnnnnn.QXF where nnnnnnnn is the BODC
series reference number. This number is used to refer to the data in the file
throughout the data documentation and may also be found in the MOORINDX
table in the SES database. It is well worth making a note of it when using the
data.

The data files are in one of two formats as indicated by their file extension.
The .LST files are in a simple ASCII format, termed BODC Request Format
Version 1.0. This format will be familiar to users who have received data from
the BODC National Oceanographic Database. The .QXF files are in QXF
format, a derivative of the NetCDF binary exchange format.  The introduction
of this format was necessary to handle both the data volume and structural
complexity of moored ADCP and thermistor chain data. Both formats are
handled transparently and output in a common grid format by the BODC
Mooring Explorer software.  It is strongly recommended that all users with
access to a Windows system should use this program as the interface to the
SES moored instrument data.

These data have been through the standard BODC moored instrument quality
control procedures, during which data documentation has been compiled.
This describes the instrumentation and data processing procedures applied
to the data by the originators and BODC. The documentation also describes
any problems or abnormalities with the data reported by the originator or



detected by BODC quality control. In some cases, vital information may only
be found in the data documentation. Therefore, ignore this document at
your peril.



Burst Recorded Data

Introduction

The STABLE II lander was deployed twice during SES, during Challenger
cruises CH121A and CH125A.  Both deployments were at site S200 (56° 27’
N, 9° 3’ W) in approximately 200 m of water. The instrument was fitted with a
range of sensors and two data loggers. The mean data logger stored a cycle
of averaged data once a minute. The data from this are included as part of
the conventional time-series data set on the CD-ROM. The second data
logger collected, approximately, 9500 scans at a frequency of 8 Hz once an
hour. These data are documented here.

Data File Location

The burst recorded data files may be found in the CD-ROM directory
MOORINGS\STABLE\STABURST. The data are located under the
appropriate directory (CH121 or CH125). There are over 500 files from each
cruise, each containing the data from a single burst.

Due to space constraints, the burst files have been compressed using the
Unix ‘zip’ utility (using, zip –l to ensure PC-compatible record terminators).
The files may be uncompressed using MS-Dos, UNIX or Windows-based
software (e.g. Pkware).  Note that if the UNIX ‘unzip’ command is used, the
‘-a’ option must be specified to convert the PC record terminators to the UNIX
form (unzip –a <filename>).

Data Documentation

STABLE II lander consisted of a large aluminium frame standing on tripod
legs fitted with syntactic foam buoyancy, two Benthos transponding releases,
mechanical releases and disposable ballast.

The frame carried a large number of sensors (Humphery and Moores, 1994a)
measuring three-dimensional currents, acoustic backscatter, temperature and
pressure.

The following sensors on the STABLE II platform were logged in burst mode:

Three electromagnetic current meter arrays (Valeport 800 series),
termed Array A (300 mm above seabed), Array B (602 mm above
seabed) and Array C (899 mm above sea bed). Each array comprised
two heads mounted on Y-shaped arms with a horizontal separation of



230 mm. The arrays were mounted such that the heads were at
identical angles to port and starboard of the lander centre-line facing
its bow (the reference point on the lander for the heading channel in
the mean data set).

A Digiquartz pressure sensor (serial number SN36626) capable of
operating at depths of up to 1400 m. This was mounted 1950 mm
above the sea floor. Note that the mean data logger used a separate
sensor.

The current sensors were calibrated prior to deployment (18 November 1993)
in the high-velocity recirculating flume at the Liverpool University Mechanical
Engineering Department that was capable of producing virtually non-turbulent
flow. The instruments were calibrated for both horizontal and vertical
currents. Due to flume size constraints, each sensor array was calibrated
separately.

Further details of the instrumentation and sensor calibrations may be found in
Humphery and Moores (1994b).

Challenger CH121A

The Challenger CH121A deployment was from 11 August 1995 until 06
September 1995. The data are stored in a simple zipped ASCII format. There
are 558 files named 001.ZIP to 558.ZIP (uncompress to burst.001 to
burst.558).  Each file contains 9600 scans.  These files DO NOT contain a
header.  The file README.TXT in the CH121 directory contains the start date
and times of each burst file, which are in sequential order, every hour,
starting at 18:59:58 UT on 07 August 1995.

The data are contained in 13 columns each containing decimal numbers
separated by at least one blank (usually two).  Columns 1 to 12 contain data
for the Electromagnetic Current Meters (EMCM) and give velocity in meters
per second.

Column EMCM Array Head Flow Component
1 A Port Horizontal
2 A Port Vertical
3 A Stbd Horizontal
4 A Stbd Vertical
5 B Port Horizontal
6 B Port Vertical
7 B Stbd Horizontal
8 B Stbd Vertical
9 C Port Horizontal

10 C Port Vertical
11 C Stbd Horizontal
12 C Stbd Vertical



Column 13 contains wave induced pressure information in bars.

The 'ECM Array' designations are defined in the Data Documentation section
above. Vertical currents are positive when flowing from the bottom of the
head to the top. Horizontal currents are positive when flowing from left to right
(viewing the sensor from the front).

Challenger CH125A

The winter deployment (Challenger cruise CH125A) was from 01 February
1996 to 22 February 1996. The data are stored in a simple zipped ASCII
format. There are 504 files named 001.ZIP to 504.ZIP (uncompress to
burst.001 to burst.504).  Each file contains 9405 scans. File README.TXT in
the CH125 directory contains the start date and times of each burst file, which
are in sequential order, every hour, starting at 07:59:59 UT 1 February 1996.
These files contain a header that appears as:

Rig: POP-UP STABLE2

Burst Number: 001

Start Date: 01:02:1996

Start Time (GMT): 07:59:59

Deployment reference: SES_CH125

Logging Frequency: 8Hz

Column information:
Columns 1 to 12 contain data for the Electromagnetic Current Meters and
give velocity in metres per second.

Column EMCM Array Head Flow Component
1 A Port Horizontal
2 A Port Vertical
3 A Stbd Horizontal
4 A Stbd Vertical
5 B Port Horizontal
6 B Port Vertical
7 B Stbd Horizontal
8 B Stbd Vertical
9 C Port Horizontal
10 C Port Vertical
11 C Stbd Horizontal
12 C Stbd Vertical

Columns 13 and 14 contain Thermistor probe temperature information.

9405 records follow the header, each containing 14 decimal numbers
separated by at least one blank (usually two). The definitions of these
numbers are defined in the header. The 'ECM Array' designations are defined
in the Data Documentation section above. Vertical currents are positive when
flowing from the bottom of the head to the top. Horizontal currents are
positive when flowing from left to right (viewing the sensor from the front).



Data Quality

The times of the first and last bursts from both cruises may be influenced by
deployment/recovery operations and should be ignored. Furthermore, the
Challenger CH121A record shows a disturbance in the bottom set of EMCM
heads at the end of the record.  The Challenger CH125A rig recovery
damaged the EMCM spare.  Thus, the data record shows the final readings to
be useless for some of the equipment.  Table 1 describes the good data for
each deployment and instruments.

The pressure sensor used on deployment CH121A was useless as it was
uncalibrated and details were lost.

Each of the EMCM heads have a “warm up” time.  This means that the first 20
seconds of every burst on both deployments are suspect.

Table 1: Good data from STABLE deployments S200 1995 & 1996.

Deployment Sensor Good Data Time of Good Data
CH121 EMCM arrays Bursts 82-480 11/08/95 03:59 to

27/08/95 17:59
CH121 Pressure NONE
CH125 EMCM arrays Bursts 2-489 01/02/96 08:59 to

21/02/96 15:59
CH125 Thermistor probes Bursts 2-489 01/02/96 08:59 to

21/02/96 15:59
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BODC Request Format
Version 1.0

This is a generalised output format to handle most types of data held in the BODC National
Oceanographic Database.

The following is an example of a file listed in the format:

BODC Request Format Std. V1.0           Headers=  15 Data Cycles=   1247 BODC QC (a)
Series:   12050 Inv: CMD  1008           Produced:1993/07/07                     (b)
Id:   048/0           United Kingdom    Scottish Office Agric. & Fisheries Dept. (c)
 57d18.1mN001d54.6mW                     Start:19700831095800 End:19701022075800 (d)
Depth: floor  22.0  sensor  18.0         Nom. sample int.:   3600        secs    (e)
    2 Parameters included:                                                       (f)
Parameter  f  P  Q     Absent Data Value  Minimum Value  Maximum Value     Units
LCDAEL01   Y 30 37                 -1.00           0.00         359.70     deg T (g)
Horizontal Current Direction            Eulerian method
LCSAEL01   Y 40 47                 -1.00           0.14          72.07    cm/sec
Horizontal Current Speed                Eulerian method
    1 FORTRAN format record:                                                     (h)
(I7,A20,A1,1X,F8.2,A1,1X,F8.2,A1)
  Cycle    Date      Time    LCDAEL01  LCSAEL01                                  (i)
 Number yyyy mm dd hh mi ssf         f         f
      1 1970/08/31 09.58.00    228.26     18.63                                  (j)
      2 1970/08/31 10.58.00    209.69     36.14
      3 1970/08/31 11.58.00    206.74     44.23
      4 1970/08/31 12.58.00    204.33     40.06
      5 1970/08/31 13.58.00    207.48     27.95

Notes:

(a) The first record contains general information regarding the file.  Std. indicates
Standard format and V1.0 indicates version 1.0 of the format. Headers and Data
Cycles are counts of the number of header records and data cycles in the file.
BODC QC indicates that the data has been through BODC quality control
procedures; this field is blank if this is not the case.

(b) Record two indicates the BODC series reference number and any inventory
reference numbers by which the series is also known (in this case the inventory is
the Moored Time Series Inventory that was originally known as the Current Meter
Inventory: hence the mnemonic).  A reference to a second inventory may occur on
this line. If a series has not yet been allocated a BODC reference number this
record will start with 'File:' followed by the full BODC file name.  This record also
indicates the date on which the output was produced (yyyy/mm/dd).

(c) Record three gives the data originator's identifier for the series, the source country
and the source laboratory.  If this information is not available the record will state
'Series header information not available' and the next two records will be blank.

(d) This record specifies one or two geographic positions; if a second position is given its
purpose will be described in the accompanying documentation.  Start date and end date



(if available) are given in the format yyyymmddhhmiss (24 hour clock and GMT). If time
is unavailable hhmiss will be blank.

(e) This record gives the sea floor depth and the sensor depth.  If a second (greater) sensor
depth is given the two sensor depths specify the range of depths over which
measurements were made.  The second half of this record gives the nominal sampling
interval and units.

(f) This record and the following title record start the parameter section.  There are two
records per parameter present.

(g) The parameter information record gives the BODC parameter name, whether the
channel has been flagged with quality control indicators (Y/N), byte pointers (P and Q) to
the start and end of the parameter within each datacycle record, the absent data value,
minimum and maximum values of the parameter within the series and parameter
storage units.  The next record gives the full parameter name and the sampling method.

(h) This line indicates the number of following records which together form the FORTRAN
format used to write each data cycle record.

(i) This and the next record are the data cycle title lines.  'f' indicates a flag channel.

(j) Data cycles are listed one per line.  The first seven characters are always a data cycle
count.  One of the following quality control flags may appear against an individual data
value (if the remark 'BODC QC' is present in record 1, then a blank flag indicates that the
value is good):

Flag Description

Unqualified
< Below detection limit
> In excess of quoted value
B Beginning of CTD downcast
D Thermometric depth
E End of CTD downcast
K Uncertain/suspect value
L Improbable value - originator's quality control
M Improbable value - BODC quality control
N Null value
P Trace/calm
Q Indeterminate
R Replacement value
S Estimated value
T Interpolated value
W Control value
X Excessive difference



QXF Format

Introduction

QXF is a binary format developed within BODC to handle multidimensional
data such as wave spectra, ADCP data and thermistor chains.  A concise
definition of multidimensional data is those data that have more than one
independent variable.  For example, for a thermistor chain temperature to
make any sense, it must be labelled with both its date/time and sensor depth.
Due to the overheads involved in software maintenance, it is proposed that
QXF will become the standard BODC binary format. It will replace PXF and
its ASCII analogue (BODC Request Format) that has previously been used
by BODC for the distribution of time series data.  For operational reasons, the
SES CD-ROM represents a transitional stage and includes data in both QXF
and BODC Request Format.

QXF is a customisation of Network Common Data Form (NetCDF) that was
developed for data exchange within the atmospheric research community in
the USA.  Its purpose is to provide a vehicle for the platform-independent
exchange of binary data.  The format is well supported by the Unidata
Program Center, managed by the University Corporation of Atmospheric
Research on behalf of the US National Science Foundation.  Interface
software written in both C and FORTRAN is freely available on the Web.
Users wishing to know more about NetCDF or wishing to write applications
against QXF should consult the UCAR Web site (www.unidata.ucar.edu).
Further support, in the form of C++ methods, is available to those wishing to
program against QXF from BODC.

NetCDF Concepts and Terminology

NetCDF considers data to consist of a series of multidimensional arrays,
each of which stores the values for a specified variable.  Some arrays will
have values for all dimensions, whilst other arrays have a lower number of
dimensions.  These may pertain to one or more dimensions of the
multidimensional arrays. One of the dimensions, usually time, is unlimited in
that the file may grow along that dimension.  Fixed storage is allocated for the
other dimensions.

Initially, this is a difficult concept to understand.  The following example may
help.  Consider thermistor chain data where temperature is measured at a
number of depths along a common time base.  The minimum number of
arrays required to store these data is three: temperature, time_stamp and
sensor_depth.  The temperature array is 2-dimensional (time, depth),
time_stamp is 1-dimensional (time) and sensor_depth is also 1-dimensional

http://www.unidata.ucar.edu


but this time the dimension is depth.  The time dimension is set to be
unlimited, whilst the depth dimension is fixed at the number of sensors on the
thermistor chain.

In addition to the data arrays, NetCDF also stores attributes.  These may be
either global or variable-specific.  Global attributes are used to store
metadata that pertains to the entire data set.  Variable-specific attributes are
used to store such items as variables’ names, absent data values, formats,
minimum and maximum data values, etc.

Mapping Between QXF and NetCDF

The first consideration is the global attributes.  The following global attributes
have been included in QXF:

SERIDN Series identifier
GOODFL Flag character used to signify good data
NULLFL Flag character used to signify null data
STOROP Currently unused (set zero)
NSCHAN Number of channels in the series
NSOFDA Offset of free space within the series array
HEADSZ Storage required besides data arrays
CYCLSZ Storage required for one datacycle

The primary reason these variables are stored in the QXF file is that they are
required by the BODC Series Class (see below).  They may therefore be
safely ignored by programmers developing applications outside the Series
Class unless the information they contain proves useful.

The variable attributes stored are the absent data value (ABS), the minimum
data value (MIN) and the maximum data value (MAX).  Note that data units
are not explicitly stored.  The variable names used in QXF are BODC
parameter codes.  This implicitly specifies the storage unit because it is part
of the parameter code definition.  These definitions may be found in the SES
Database or in the moored instrument data documentation.

QXF also includes quality control flag variables in addition to the data
variables.  These may be recognised and linked to their related data variable
through their variable name.  This is 9 bytes long instead of 8.  The first byte
is always ‘F’ and the other 8 bytes are the name of the associated data
channel.

The QXF data on the SES CD-ROM have two dimensions specified: primary
and secondary.  The primary dimension is unlimited in size and represents
time.  The secondary dimension is limited to the number of measurement
depths and represents measurement depth.  Note that temperature probes



have been implemented in QXF as if they were single-bead thermistor
chains.

One final complication requires some explanation.  The time stamp in QXF is
implemented as two variables rather than one to reflect the way in which date
and time are handled within BODC.  The first variable, AADYAA01, defines
the date in terms of what is known locally as a Loch day number. This is the
number of days that have elapsed since the start of the Gregorian calendar.
Source code (FORTRAN and Pascal) is provided in the Underway Data Set
section of this manual, which converts a Loch day number into year month
and day.  The second variable, AAFDZZ01, stores time as a floating-point
day fraction (06:00 = 0.25, 12:00 = 0.5 etc.).

The BODC Series Class

Within BODC, QXF data files are interfaced through a C++ class known as
the BODC Series Class.  This concept, plus the associated class library, will
be of great interest to anyone wishing to develop C++ applications against
QXF files.  Those who wish to know more are invited to contact BODC for
further information (e-mail: bodcmail@ccms.uk.ac).

Making use of data in QXF

The first message to users who have access to a Windows system is that the
easiest way to use the QXF data on the SES CD-ROM is via the BODC
Moorings Explorer program.  This handles both moored instrument data
formats present on the CD-ROM with equal ease.

Users on other platforms will generally need to develop software if they wish
to use the QXF data on the CD-ROM.  Note that this is not restricted to
conventional language programming: NetCDF data may be imported directly
into packages such as MatLab and then manipulated through command
language macros.

Another relatively simple route into the data is through the ‘ncdump’ utility.
This general-purpose NetCDF to ASCII conversion utility is freely available
for UNIX platforms.



BODC Mooring Explorer Software

The BODC Mooring Explorer is a Windows application that allows the moored
instrument files on the CD-ROM to be plotted as stacked time series.  The
data may also be listed in a grid format that may be exported to other
applications, such as spreadsheets. The mooring position may also be
displayed overlaid on a map of GEBCO bathymetry.

The program has been tested successfully under Windows95, Windows98
and Windows NT 4.0.  It contains on-line help, including functional
descriptions of all the menu options and control buttons. However, a brief
description of how to get started is included here.

When the program is launched through either the BODC entry in the Start
menu, a shortcut or Windows Explorer, a splash screen is briefly displayed
followed by the opening of the program control window. The following actions
are then required to display data.

• Select the Open Project option from the File menu and choose the project
appropriate to the CD-ROM currently loaded.

• Click on the Select menu to open the Selection Dialog, which allows the
series of interest to be specified. The form is in three parts.  The top,
‘Primary data selection criteria’, allows various selection criteria to be
specified.  The result of this is to restrict the choices available in the other
two sections to entries matching the selection. The selection may be
refined, if desired through the ‘Secondary data selection criterion’ section.
Once the number of series displayed in the bottom section of the form has
been reduced to a manageable number, the series of interest may be
chosen by a mouse left-click. Note that more than one series may be
chosen at this stage.

• Press ‘OK’ to open the View Dialog. This controls the series, or part of a
series, which is to be plotted or listed.  The time interval, data channels
and quality control flag values may all be used to restrict what is
displayed.  If you don’t like working with parameter codes, right click in the
Parameters Available window to get plain language definitions.  This
dialog may be opened at any time to update the selection criteria by
selecting the Moorings option from the View menu.

• Click on one or more of the three large control buttons to open the plot
window, data grid or mooring location map. The icons on the buttons
clearly indicate which button does what.

This is all you need to do to access the data. Control over how the data are
presented is provided through both the menus and the toolbar buttons.
Consult the on-line help or simply experiment to discover what these can do.
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